
Menus

File Menu
Project Menu
Script Menu
Tools Menu
Options Menu
Register
Windows Menu
Help Menu



File Menu

The file menu permits you to open, create and save project files.    It also gives you access 
to the printer configuration and target file printing functionality.



New (File menu)

If you want to create a new AutoDoc project, select this menu item.    A new Project Window
will be opened.    This project will not have any target files defined.



Open... (File menu)

If you want to open a project file, select this menu item.    The Project Open dialog will be 
displayed so that you can select the project file.
You can use the File List on the File menu to quickly open a project you previously had 
open.



Close (File menu)

This item can be used to close the current project window.    If the project has been modified
since it was last saved, you will be asked if the project should be saved before the window 
is closed.
You can also close a project window by pressing Ctrl-F4.



Save (File menu)

Whenever you want to save the project's information, select this menu item.    If the project 
has been saved before, the project file will be updated with the project's current 
information.    If the project has never been saved, selecting this item acts exactly like the 
Save As... menu item.



Save As... (File menu)

The first time you save a project (or when you wish to save it to a new file), select this item 
from the File menu.    The Project Save As dialog is displayed.    Using this dialog you can 
specify the file used to save the project.



Print... (File menu)

If you want to format or print one or more of the target files in the project, select this menu 
item.    A dialog specific to the word processor selected in the Print Options dialog will be 
displayed permitting you to select which targets are to be formatted (printed).



Print Setup... (File menu)

In order to select the printer used to print formatted target files, select this menu item.    
The Print Setup is displayed listing the available printers.



File List (File menu)

Up to the last 4 projects you have worked on are listed on the File menu.    To open one of 
these projects, simply select the project from the list.



Exit (File menu)

To close the application, select this item on the File menu.



Project Menu

The project menu provides menu equivalents to the extraction buttons available on the 
project window.



Project Wizard (Project menu)
When this option is selected, the project wizard dialog is displayed.    This dialog is designed
to simplify the process of creating new AutoDoc projects.



Build all (Project menu)

When you select this menu option, each target file is rebuilt if necessary.    To determine 
whether a target file must be rebuilt, AutoDoc checks the target file's date and time against
the date and time of each of the source files associated with the target.    If the target file 
does not exist or any one of the source files was modified more recently than the target 
file, the target file is rebuilt.



Make all (Project menu)

Selecting this option tells AutoDoc that you want each of the target files rebuilt regardless 
of the date and time of the constituent source files.



Build target (Project menu)

When you select this menu option, the selected target file is rebuilt if necessary.    To 
determine whether the target file must be rebuilt, AutoDoc checks the target file's date and
time against the date and time of each of the source files associated with the target.    If the
target file does not exist or any one of the source files was modified more recently than the
target file, the target file is rebuilt.



Make target (Project menu)

Selecting this option tells AutoDoc that you want the target file rebuilt regardless of the 
date and time of its constituent source files.



Script Menu
The Script menu provides options for defining and executing AutoDoc command script 
files.



Record... (Script menu)
Use this open (or the associated toolbar button) to start and stop recording a command 
script.    When this item is checked, a script is being recorded.

To begin recording...
Select this menu item or click the record button on the toolbar.    The Script Record dialog 
will be displayed.    Specify the file to which the script commands should be written.

To stop recording...
When this menu item is checked, either click the record button on the toolbar or reselect 
this menu item.



Run... (Script menu)
Use this option (or click the associated toolbar button) to begin execution of a previously 
created command script.    When selected, this option displays the Script Run dialog.    Use 
this dialog to select the command script to be executed.



Script List (Script menu)
This section of the Scripts... menu lists up to 4 command scripts which have been 
executed.    Selecting one of the items in this section executes the script as if you had 
selected the script file using the Script Record dialog.



Options Menu

The Options menu provides access to the dialogs you can use to customize the 
functionality of AutoDoc.



Extraction... (Options menu)

To specify the extraction options used while building target files, select this menu item.    
The Extraction Options dialog will be displayed so that you may make your selections.



Keywords... (Options menu)

To define keyword sets or to modify the keyword definitions in an existing keyword set, 
select this menu item.    The Keyword dialog will be displayed.



Languages... (Options menu)

This menu item is used to access the Language dialog.    This dialog gives you the ability to 
define and modify language definitions used during the extraction process.



Printing... (Options menu)

In order to format and print target files, you must select the word processor to be used by 
AutoDoc.    By selecting this menu option, the Print Options dialog is displayed.



Protect project... (Options menu)
Using this option, a password can be assigned to a project.    Once this is done, changes 
cannot be made to the target and source files of the project unless the project is 
unprotected (see Unprotect (Options menu)).

After a password is assigned to a project, it is still possbile to extract the targets and save 
the extraction information.    Changes to the rest of the project are prevented.



Unprotect project... (Options menu)
This option is used to remove a password which has been assigned to a project.    Once the 
password is removed, changes can be made to the target and source files defined in the 
project.



Toolbar - Hide (Options menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in AutoDoc, such as File Open.    A check mark appears next to 
the menu item when the Toolbar is hidden.



Toolbar - Small (Options menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in AutoDoc, such as File Open.    A check mark appears next to 
the menu item when the Toolbar is hidden.



Toolbar - Large (Options menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in AutoDoc, such as File Open.    A check mark appears next to 
the menu item when the Toolbar is hidden.



Toolbar - Large with Text

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in AutoDoc, such as File Open.    A check mark appears next to 
the menu item when the Toolbar is hidden.



Status Bar (Options menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state.
A check mark appears next to the menu item when the Status Bar is displayed.



Tools Menu

The Tools menu provides you with the ability to launch other applications while running 
AutoDoc without having to switch to the Program Manager.



Select... (Tools menu)

In order to add and remove applications from the Tools menu, select this item.    The Tools 
Management dialog is displayed when this item is selected.



Execute... (Tools menu)

If you want to launch an application that is not on the Tools menu (and you do not want to 
swith to the Program or File Manager), select this menu item.    The Tool Selection dialog is 
displayed so that you can pick the application to be executed.



Tools List (Tools menu)
This section of the menu lists the tools which you have specified using the Tools 
Management dialog.    Selecting one of the tools from this list will execute the command 
associated with the tool.



Register...

The AutoDocumentation System is a Shareware package.    To register you copy of the 
software, select this option.
When you register your copy of AutoDoc, you will receive

A copy of the latest version of the software
Updates for the next six (6) months
A copy of the printed manual
Notification of any new releases



Windows Menu

This menu permits you to organize the project windows that are open or to access a 
particular project window when it is not visible.



Tile (Windows menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Cascade (Windows menu)

Use this command to arrange multiple opened windows in an overlapped fashion.



Arrange icons (Windows menu)

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



Help Menu

If you need help with an aspect of AutoDoc, you can use the items on this menu to access 
the on-line help system.



Index (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you 
can jump to step-by-step instructions for using the AutoDocumentation System and various
types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help (Help menu)

Use this command for instructions about using Help.



What's New

Version 2.00.92
Version 2.01



Version 2.00.92

Version 2.00.92 was release on June 13, 1994 to the general public.    This version was the 
culmination of over 4 years work on the AutoDocumentation System.



Version 2.01

Following closely after version 2.00.92, version 2.01 include many enhancements to the 
product to enhance its usability, flexibility and performance.

Major enhancements and changes include the following.

Word processors can now be assigned to individual projects.    This means 
you no longer have to reset the word processor when switching between 
projects which must be formatted differently.
Word processor macroes can be assigned to projects and targets.    This 
permits you, for example, to create a single project file which contains both
API documents and user manuals.
Project and target file Wizard dialogs were added to assist in the creation 
of new projects.
Keyword files can be assigned to projects, targets and source files.    This 
makes it easier to include files from different languages into a single 
project.
Three different button bars are available which use small buttons, large 
buttons or large buttons with text descriptions.
The last 20 project files which have been opened are remembered and are 
available from the project open dialog.
All of the word processor macroes have been optimized to run faster.
When printing, it is now possible to select only those target files which 
have been updated since they were last formatted.
A startup Cue card has been added.    If you are new to AutoDoc, this dialog
and the Wizards will help you to learn the application.
The on-line help has been greatly enhanced to make it easier to locate the 
information you need.
Password protection is now available for projects to prevent changes being 
made.



Registering AutoDoc

AutoDoc is a shareware product.    This means that it is not free.    Instead, you are given a 
chance to try the software to determine if it will meet your needs.    If it does, you are asked
to send the author a registration fee.

To register the software, select the Register... item on the Options menu.

When you register the product, you receive the following benefits.

A diskette containing an up-to-date version of the product registered in 
your name.
A copy of the printed user's manual.
Free updates for 6 months.
On-going notification of new releases of AutoDoc.



Technical Support

If for some reason you need to contact the author to suggest an enhancement or have a 
question answered, you can do one of the following.

Send an e-mail on CompuServe to 72164,642
Send an e-mail on Internet to RCOOK@NETCOM.COM
Send a letter via USMail to:
Russell Cook
PO Box 1551
Evanston, IL 60204



About...

Use this command to display the copyright notice and version number of your copy of 
AutoDoc.



Shareware

Shareware software is a type of software that permits you to use the software on a trial 
basis.    If you find the software useful, you are asked to register the software with the 
author.    You may also make copies of the software and provide it to others that may find 
the software useful.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    
The toolbar provides quick mouse access to many tools used in AutoDoc,

To hide or display the Toolbar, choose Toolbar from the Options menu (ALT, O, T).

Click To
Open a new document.
Open an existing document.    AutoDoc displays the Open dialog box, in 
which you can locate and open the desired file.
Save the active document or template with its current name.    If you 
have not named the document, AutoDoc displays the Save As dialog 
box.
Print the active document.
Create a new project using the ProjectWizard and TargetWizard dialogs
Extract the target file selected in the Target List: if necessary
Extract all of the target files listed in the Target List: if necessary
Force extraction of the target file selected in the Target List:

Force extraction of all of the target files listed in the Target List:

Start/stop recording a command script
Run a command script
Launch the help system
Enter context-sensitive help mode

Status Bar

The status bar is displayed at the bottom of the AutoDoc window.    To display or hide the 
status bar, use the Status Bar command in the Options menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the 



description of the toolbar button command you wish not to execute the command, then 
release the mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.

Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button

Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with 
the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) 

to move the pointer to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the AutoDoc window to an icon.

Shortcut
Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut
Mouse: Click the maximize icon  on the title bar; or double-click the title

bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    AutoDoc determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    AutoDoc determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on 
the document Control menu closes only one window at a time.    You can close all windows 
at once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:

Task List
Select the application you want to switch to or close.
Switch To
Makes the selected application active.
End Task
Closes the selected application.
Cancel
Closes the Task List box.
Cascade
Arranges open applications so they overlap and you can see each title bar.    This 
option does not affect applications reduced to icons.
Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.
Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Context-sensitive Help

Use the Context Help command to obtain help on some portion of AutoDoc.    When you 
choose the Context Help button, the mouse pointer will change to an arrow and question 
mark.    Then click somewhere in the AutoDoc window, such as another Toolbar button.    The
Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Application Window
This is the application window for AutoDoc.    For each project you open or create, a new 
project window is created within the application window.



Keywords

All of the documentation you embed in your source files must use keywords.    Keywords are
sequences of characters which have special meaning to AutoDoc.    During the extraction 
process, AutoDoc uses the keyword set you have selected for the project (see Setting 
Project Summary Information) to find and transform information in the source files.
There are two kinds of keywords: base keywords and user-defined keywords.    Generally, 
any keywords you define should map to one of the base keywords.    The word processor 
macroes are designed to format target files which contain only keywords from the base 
keyword list.    (If you need to, you can modify the word processor macroes to support 
additional base keywords but this is not, in general, recommended.)



Base Keywords

These keywords are defined by the AutoDocumentation System.    The word processor 
macroes are defined to process these keywords and to ignore all others.    You can view the 
definitions of the base keywords using the base keywords dialog.



User-Defined Keywords

Sometimes referred to as aliases, user-defined keywords permit you to use a keyword with 
a special name or meaning in your source files.    The regular expressions associated with a 
user-defined keyword should map the keyword to a base keyword.    To define new 
keywords, use the keyword dialog.



Command Script
A command script defines a set of operations which can be executed without user 
interaction.    Each operation to be executed is defined using a command-line option.    
Command scripts are stored in files which can be recorded using the Record... option on 
the Script menu.
To execute a command script, you can select the Run... option on the Script menu, select 
a script file that is listed on the Script menu or, using the @script-file command-line 
parameter, specify a comman script to execute when AutoDoc is run.



Command Line Parameters

You can use the following command line parameters when executing AutoDoc.    Command 
line parameters must be prefixed by either a dash ('-') or a forward-slash ('/').    The two 
exceptions to this rule are ? (when help is requested) and when specifying a project file to 
be opened.

NOTE: In the following table, square brackets ([ ]) are used to enclose optional characters.

[ -P | -p ]project-file
project-file

Open the project specified by project-file.    The 
project filename may be separated from the 
command switch by one or more spaces.

@command-file Execute the command script contained in command-
file

[    -B | -b ] Conditionally build all of the extraction files
[    -K | -k ] Unconditionally build all of the extraction files
[    -S | -s ] Save the project information
[    -C | -c    ] Close the open project
[    -P | -p    ] Format and print one copy of all of the extraction files
[    -F | -f    ] Format all of the extraction files
[    -X | -x    ] Exit AutoDoc
[    ? | -?    ] Display this help information



Error Messages
'project-name' has been modified.    Should it be saved before closing?
A command script is currently being recorded.    Should the selected script be inserted 
Cannot access base keyword information.
Cannot access keyword information in 'filename'.
Cannot access language information in 'filename'.
Cannot open source file 'filename'.
Cannot open target file 'filename'.
Cannot save information to 'filename'.
Insufficient memory available to complete operation.
No target files are defined for the project.
Printing options have not been specified.    Would you like to specify them now?
Project file 'filename' does not exist.
Should the source file definition be added to the target definition?
Source file 'filename' has no start and/or stop regular expression for use during 
Source file 'filename' uses unknown language 'language-name'.
The entered passwords do not match.
The keyword definition has been modified.    Should it be saved?
The keyword set has been modified.    Should it be saved?
The language definition has been modified.    Should it be saved?
The specified directory does not exist.    Should it be created?
The specified password does not match the project's password.
The specified script file exists.    Should it be overwritten?
The specified script file exists.    Should the new commands be added to it?
Too many source files associated with target.
Too many targets exist in the project.
Unable to access project file 'filename'.
Unable to create the specified directory.
Unable to launch requested tool.
Unable to open source-specific keyword file <filename>.
Unable to open target-specific keyword file <filename>.



'project-name' has been modified.    Should it be saved before 
closing?

Error Cause The project being closed has been modified without 
being saved.    Projects are typically modified when 
target files are added, modified, or deleted.    Further, 
extracting the target files also modifies a project.

Error Fix Respond YES if the modifications should be saved. 
Respond NO if the changes should be discarded.

A command script is currently being recorded.    Should the selected
script be inserted 

Error Cause While recording a command script, another script was
selected for execute.

Error Fix Response YES to append the commands of the 
existing script to the script being recorded.    Respond
NO if the recording of the new script should be 
paused while the existing script is executed.

Cannot access base keyword information.
Error Cause During the extraction process, the base keyword 

information could not be obtained.
Error Fix The base keyword information is stored in 

BASEKYWD.ASK in the application directory.    If this 
file does not exist, is not readable or is in use by 
another user or application, its information will not be
loaded.

Cannot access keyword information in 'filename'.
Error Cause During the extraction process, the keyword 

information stored in the specified file could not be 
obtained.

Error Fix Make sure the keyword file exists, is readable and is 
not in use by another user or applicaiton.

Cannot access language information in 'filename'.
Error Cause During the extraction process, the language 

information stored in the specified file could not be 
obtained.

Error Fix Make sure the language file exists, is readable and is 
not in use by another user or applicaiton.



Cannot open source file 'filename'.
Error Cause During the extraction process, the specified source 

file required processing but the file was not available.
Error Fix Make sure the file exists, is not in use and, if stored 

on a network drive, that the necessary access rights 
have been granted.

Cannot open target file 'filename'.
Error Cause While extracting the target files, the specified file 

could not be created.
Error Fix Make sure that the path to the file's directory exists. 

If the file is to be created on a network drive, make 
sure that the appropriate access rights are available. 
Finally, ensure no one else is using the file.

Cannot save information to 'filename'.
Error Cause The specified file is read-only, is in use by another 

user or applicaiton or the directory in which the file is 
to be output does not exist.

Error Fix If the file exists, make sure that is not read-only and 
is not in use by another user or application.    If the 
file is stored on a network drive, make sure that the 
necessary access rights exist.

Insufficient memory available to complete operation.
Error Cause An attempt was made to allocate memory which 

failed.
Error Fix Close one or more other applications to make more 

memory available.

No target files are defined for the project.
Error Cause An operation was initiated which requires one or 

more target files although none exist.
Error Fix Define one or more target files before attempting the 

operation.

Project file 'filename' does not exist.
Error Cause An attempt was made to open the specified project 

file which does not exist.
Error Fix Ensure that the file exists.    If the file is stored on a 



network drive, make sure the necessary access rights
have been granted.

Source file 'filename' has no start and/or stop regular expression 
for use during 

Error Cause While attempting to process the specified source file, 
one or both of the required regular expressions were 
unavailable.

Error Fix Make sure that both a start and stop regular 
expression is defined for the source file or for its 
parent target file.

Source file 'filename' uses unknown language 'language-name'.
Error Cause While attempting to process the specified source file, 

it was not possible to obtain the comment regular 
expression for the indicated language.

Error Fix This problem occurs when a language definition is 
deleted.    Make sure the language is defined.

The keyword definition has been modified.    Should it be saved?
Error Cause The description or regular expressions for the 

selected keyword have been modified without being 
saved.

Error Fix Respond YES if the modifications should be saved. 
Respond NO if the changes should be discarded.

The keyword set has been modified.    Should it be saved?
Error Cause One or more changes have been made to the 

keywords which comprise the current keyword set 
without being saved.

Error Fix Respond YES if the modifications should be saved. 
Respond NO if the changes should be discarded.

The language definition has been modified.    Should it be saved?
Error Cause The filename filter or comment regular expressions 

for the selected language have been modified 
without being saved.

Error Fix Respond YES if the modifications should be saved. 
Respond NO if the changes should be discarded.



The specified directory does not exist.    Should it be created?
Error Cause The selected directory does not exist.
Error Fix Respond YES if the directory should be created.    

Respond NO if the directory should not be created.

The specified script file exists.    Should it be overwritten?
Error Cause An existing command script file was selected for use 

while recording commands.
Error Fix Respond YES if the existing file should be deleted and

recreated.    Respond NO if the file should not be 
deleted.

The specified script file exists.    Should the new commands be 
added to it?

Error Cause An existing command script file was selected for use 
while recording commands.

Error Fix Respond YES if the script file should have the new 
commands appended to it.    Respond NO if the 
existing script file should not be modified.

Too many source files associated with target.
Error Cause An attempt was made to add a new source file to the 

target file after the maximum number has been 
reached.

Error Fix Delete one or more source files from the target.

Too many targets exist in the project.
Error Cause An attempt was made to add a new target file to the 

project after the maximum number of targets has 
been reached.

Error Fix Delete one or more targets from the project.

Unable to access project file 'filename'.
Error Cause The specified file was to be opened for access.    

During the process of opening and reading the file, an
error occurred.

Error Fix This error can result from a corrupt project file, if the 
file is in use by another user or if the file is on a 
netword drive and the necessary access rights have 
not been granted.



Unable to create the specified directory.
Error Cause After responding that the directory should be created,

the attempt failed.
Error Fix Make sure the parent directory of the specified 

directory exists.    If the directory to be created is on a
network drive, ensure that the necessary access 
rights have been granted.

Unable to launch requested tool.
Error Cause An error was encountered attempting to execute the 

command associated with the selected tool.
Error Fix Check that the command is correct and that the 

necessary file is accessible.

Printing options have not been specified.    Would you like to specify
them now?

Error Cause An attempt was made to print the current project 
without the printing options being specified.

Error Fix If you would like to specify the printing options to be 
used, click the Yes button.    Doing so will cause the 
Print Options to be displayed.    If you want to specify 
the printing options at a later time, click the No 
button.



Should the source file definition be added to the target definition?
Error Cause A source file definition has been input but not saved 

on the TargetWizard dialog.
Error Fix Click YES to save the source definition and close the 

dialog.    Click NO to close the dialog without saving 
the source definition.    Click CANCEL to return to the 
dialog.

The entered passwords do not match.
Error Cause While attempting to password protect a project, the 

confirmation password did not match the original 
password.

Error Fix Reselect the Protect item on the Options menu and 
respecify the password.

The specified password does not match the project's password.

Error Cause While attempting to unprotect a project, the 
password provided did not match the password used 
to protect the project.

Error Fix Reselect the Unprotect item on the Options menu to 
respecify the password.



Unable to open target-specific keyword file <filename>.

Error Cause During extraction, the specified keyword file 
associated with one or more source files could not be 
accessed.

Error Fix Ensure that all keyword files to be used by the project
exist and can be accessed.

Unable to open target-specific keyword file <filename>.

Error Cause During extraction, the specified keyword file 
associated with one or more target files could not be 
accessed.

Error Fix Ensure that all keyword files to be used by the project
exist and can be accessed.



Regular Expressions

Regular expressions (sometimes referred to as regexs) form the foundation of much of the 
AutoDocumentation System.    They are especially important to the proper extraction of 
information from your source files.
Regular expressions are comprised of two parts: the match pattern and the replace pattern.
The general format of a regular expression is as follows.

/match pattern/replace pattern/
As you can see, slashes (/) are used to denote the beginning and end of the regular 
expression and to separate the match and replace patterns.

See Also
Symbols With Special Meanings
Inserting A Linebreak
Remembering What Was Matched
Examples



Match Pattern

This pattern is used to determine whether the replace pattern should be applied to the 
input text.    This pattern cannot be empty.



Replace Pattern

This pattern defines how the input text should be transformed into the output text.    This 
pattern is only applied when the match pattern is satisfied by the input text.    It is 
permissible for this pattern to be empty.



Symbols with Special Meaning

There are a number of symbols that may be used in regular expressions which have special
meaning.    The following list provides an overview of the symbols and their use.    See the 
Examples section for actual instances of their use.

Symbol Use
\ The escape symbol.    This symbol is used to interpret the next 

character as a normal character instead of as a symbol with special 
meaning.

^ Beginning of line.
$ End of line.
. Any character.
* Zero or more repetitions of the previous character or pattern.
\( and \) Match and remember the sequence defined between the 

parenthesis.    
Note: In this instance, the escape symbols change the 
interpretation of the parenthesis from being normal characters to 
symbols with special meaning.    This is the reverse of the normal 
behaviour for the escape symbol.

[ and ] Defines a set of set of characters to be matched.
- The dash symbol indicates that any character contained in the 

range should be considered a match.
\1, \2, \3 When used in the replace pattern and followed by a digit from 1 to 

9, the escape symbol indicates that the character sequence 
matched in the input text should be placed in the output text at the 
current location.



Examples

The following examples provide some insight to ways that regular expressions can be 
constructed.    These examples do not attempt to show every possible use or combination 
of the symbols which may be used in regular expressions.
/^@CHAPTER:.*_EXTFNCT$//

This regular expression will only match input text which starts the line with 
@CHAPTER: and ends the line with _EXTFNCT.    As indicated by the .*, zero or more
characters may separate these to literals.    If a match is successful, a blank line is 
placed into the output text since the replace pattern is empty.

/^@END.*$/@LINE/
This pattern transform one literal in the input text into a different literal in the output 
text (this is exactly how keywords are used).
The literal @END is matched in the input text as long as it is the first thing in the 
input.    It may be followed by zero or more characters before the end of the line.    If 
matched, the input text is replaced by the literal @LINE (a base keyword in AutoDoc).

/^[whitespace]*\/\/[whitespace]*\(.*\)$/\1/
This is a regular expression which matches the C and C++ comment prefix // and 
remembers the text of the comment.    First, it permits zero or more whitespace 
characters to appear at the beginning of the input text.    Next, it must matches two 
slashes (notice that the slashes must be escaped to be recognized).
Following the slashes, zero or more whitespace characters are matched and 
discarded.    Following any whitespace, everything up to the end-of-line is match and 
remembered.
If the match pattern is satisfied, the remembered text is output.

One of the most complex set or regular expressions defined by AutoDoc is used to process 
the @PARAM base keyword.    Let's look at the most complex of the regexs defined for this 
keyword.    (NOTE: whitespace has been abbreviated as WS to save space in this example.)

/^@PARAM[WS][WS]*\([^WS][^WS]*\)[WS][WS]*\([^WS][^WS]*\).*$/@PARAM
Parameter
Type & Description
\1
\2/
There is something to be noted about this pattern.    Specifically, the use of [^WS] indicates
that any non-whitespace character should be matched.    This is a case of using the ^ 
symbol in a special way (see Special Symbols).    Further, by using [^WS][^WS]*, we 
require that 1 or more non-whitespace characters appear in the input text.    Using [WS]
[WS]* requires one or more whitespace characters exist.
So, this regex can be read as follows.

Starting at the start of the line, match @PARAM followed by one or more whitespace 
characters.    After the whitespace characters, match and remember one or more non-
whitespace characters.    Next, match and discard one or more whitespace characters.



Now, match and remember a second sequence of one or more non-whitespace 
characters.    Finally, discard the rest of the line.
If a match is successful, output @PARAM, a linebreak, two fixed strings (Parameter 
and Type & Description) on separate lines, the first remembered match, another 
linebreak and the second remembered match.

Whew!    That is definitely a lot of information packed into a single regular expression.    
What it means is that the following input lines are matched and output as shown.

Input Output
@PARAM count char @PARAM

Parameter
Type & Description
count
char

@PARAM someReallyLongName double @PARAM
Parameter
Type & Description
someReallyLongName
double



Inserting A Linebreak

It is not possible to have a match pattern which spans multiple lines.    However, you can 
insert a linebreak into the replace pattern.    To do so, you must enter an escape symbol 
(see Special Symbols) followed by a new line.
For example, the following replace pattern outputs the keyword @HEADING followed by a 
linebreak followed by the text of the first field matched in the match pattern.

/@HEADING\
\1/



Remembering What Was Matched

Often, you will want to define a regular expression which remembers what was matched in 
the input text and output the matched text in a different order or format.    Using the \
( and \) symbols, you can do this.
Let's say that you have the following input text.

File: test.c, line: 1025
The following match pattern could be used to match this text and remember the name of 
the file and the line number.

/^File:[whitespace]*\([A-Za-z\.]*\).*line:[whitespace]*\([0-9]*\).*$/
This is a complex pattern so let's take each piece and analyze it.

Subpattern Interpretation
/^File: The / indicates the start of the match pattern, the ^ 

indicates the start of the line and File: is a literal which must
be matched.

[whitespace]* [] are used when one or more characters may be matched to
satisfy a subpattern.    Further, since a * immediately follows,
it means that 0 or more repetitions of the sequence should 
be accepted.    Therefore, this subpattern will match a 
sequence of zero or more spaces and tabs in the input text.

\([A-Za-z\.]*\) The \( and \) indicate that what is matched in this subpattern
is to be remembered.    Further, since this is the first field to 
remember, it can be referenced by \1 in the replace pattern.
Once more the []* means to match zero or more occurrences
of the character set within the brackets.
A-Za-z specifies two ranges of characters that can be 
matched (namely, all the upper and lowercase letters).    This
notation is very useful in this case so that all 52 upper and 
lower case letters do not have to be listed.
Finally, \. indicates that a period may also be matched.

.* This sequence indicates that zero or more occurrences of 
any character can be matched.

line:[whitespace]* This sequence requires that the text line: be seen in the 
input text followed by zero or more tabs and/or spaces.

\([0-9]*\) Similar to the first remembered field, this one indicates that 
zero or more digits should be matched and remembered.    
They can be referenced by \2 in the replace pattern.

.*$/ The .* again indicates that zero or more repetitions of any 
character should be matched.    The $ indicates that the end-
of-line must occur.    The $ is not truly necessary in this case 
since the .* is guaranteed to match everything after the line 
number.    Finally, the / indicates the end of the match 
pattern.

Now, once we've matched the input text, let's say we want to output a message formatted 
like this.



Error occurred on line #### in file filename.
To do this we would use the following replace pattern.

/Error occurred on line \2 in file \1./
We use \2 to substitute the line number found by the match pattern and \1 to use the 
filename that was identified.



Whitespace

Whitespace is either a tab or a single space.    Since it is not possible to see a space or a 
tab, whitespace is used to indicate where you should enter a space and tab.



Dialogs

Base Keywords Registration
Directory Selection Script Record
Extraction Options Script Run
Keyword Definition Source Browse
Keyword Open Source File Definition
Language Definition Startup Action Prompt
Print Options Target Browse
Print Setup Target File Definition
Project Open Target Options
Project Save As Target Wizard
Project Options Tools Management
Project Window Tool Selection
Project Wizard Unprotect Project
Protect Project



Base Keywords

This dialog can be used to view the definition of the base keywords supplied with AutoDoc.



Base Keywords - Help

Click this button or press Alt-? to obtain help on the dialog.



Base Keywords - Keyword List

This field lists the keywords defined by the AutoDocumentation System.    These are the 
keywords which are recognized by the word processor macroes.



Base Keywords - Description

This field provides a description of the information associated with the keyword.    
Generally, it describes the number of fields associated with the keyword and any special 
restrictions associated with the use of the keyword.



Base Keywords - Regular Expressions

This field lists the regular expressions defined for the keyword.    These expressions are 
used during the extraction process to transpose the information in the source file into a 
format which can be processed by the word processor macroes.    Generally, this means 
placing each field of a multi-field keyword onto a separate line in the target file.



Base Keywords - Close

Click this button to close the dialog.



Directory Selection

This dialog is used to specify the startup directory for a project.



Directory Selection - Directory

To specify a directory, you can either type the path information into the edit field or select 
the directory in the listbox.



Directory Selection - Drive

This field shows the current drive.    Use this field to select the drive of the directory you 
plan to select.



Directory Selection - OK

Click this button to select a directory.    If the directory does not exist, a prompt will be 
displayed asking if it should be created.



Directory Selection - Cancel

Click this button to close the dialog without selecting a directory.



Extraction Options

This dialog permits you to define the options used during the extraction process.



Extraction Options - Help

Click this button or press Alt-? to obtain help.



Extraction Options - Case Insensitive

The comparisons made during the extraction process may be case-sensitive (A is not the 
same as a) or case-insensitive (A is treated the same as a).    You select the case-sensitivity
using this checkbox.
If you specify case-insensitive, each line of text read from a source file is converted to 
upper-case before being match against the regular expressions.



Extraction Options - Multiple Substitution

If you so desire, the extraction process can repeatedly process each line of text from a 
source file until no match is achieved with any regular expression.    This is known as 
multiple substitution.    It can be useful if you want to "chain" a number of keywords 
together (@CHAPTER --> @TOPIC --> @HEADING).
In general, it is not recommended that you enable multiple substitution unless you are 
certain it is necessary.    This is because of the increased time that is required during 
multiple substitution processing and because of the possibility of creating an infinite loop 
(@CHAPTER --> @TOPIC --> @SOMETHING --> @CHAPTER --> @TOPIC -->.......).



Extraction Options - Save Data

While processing a source file, each file offset which matches the extraction initiator is 
remembered.    Once the source file is fully processed, the set of offsets can be saved or 
discarded.    This option specifies which is to occur.
If the source file is not modified, future extractions will be faster if the offsets are saved.



Extraction Options - Ignore Data

This option informs the extractor whether to use or ignore the extraction offsets which may 
be associated with a source file.    Using the extraction offsets determined in a previous 
extraction process can greatly reduce the time to construct a target file since each line of a
source file does not have to be processed.



Extraction Options - Progress Bar

During the extraction process, an abort box is displayed.    The target file being constructed 
and the source file being processed are listed in the box.    Further, the box can display a 
progress bar showing the percentage of the source file which has been processed.    
Alternatively, the box can display each line of text from the source file as it is processed.    
You specify whether to display the progress bar or source text using this option.



Extraction Options - Minimize

AutoDoc can minimize itself during the extraction process.    Select this option if you want 
this to occur.



Extraction Options - OK

Click this button to save the current settings and close the dialog.



Extraction Options - Cancel

Click this button to discard any changes made to the options and close the dialog.



Keyword Definition

This dialog permits you to define new keyword sets and to modify existing sets.



Keyword Definition - File

This field displays the name of the keyword file currently modified.



Keyword Definition - Help

Click this button or press Alt-? to obtain help on the dialog.



Keyword Definition - Keyword List

This field lists the keywords currently defined in the keyword file.    To add a new keyword, 
enter its name in this field.    To modify an existing keyword's definition, select the keyword 
from the list.
Remember that any keyword must begin with a @.



Keyword Definition - Description

This field provides a description of the keyword and how it can be used.    For new 
keywords, you should describe the number of fields associated with the keyword and the 
contents of each field.



Keyword Definition - Regular Expressions

This field is used to define how the text associated with the keyword is transformed before 
being output to the target file.    More than one regular expression may be defined for the 
keyword.    During the extraction process, the regular expressions are used in the order they
are listed in this field.    Therefore, enter the expressions from most restrictive to least 
restrictive.



Keyword Definition - Default Set

Every project must specify a keyword file to be used during the extraction process.    By 
selecting this option, you indicate that the current keyword set should    be automatically 
associated with any new projects you create.



Keyword Definition - OK

Click this button to close the dialog.    If any changes have been made, you will be asked if 
they should be saved.



Keyword - Cancel

Click this button to close the dialog without saving any changes made since the keyword 
set was last saved.



Keyword Definition - Save

Click this button to save the changes you have made to the keyword set.    If the set has not
been previously saved, this button acts the same as the Save As... button.



Keyword Definition - Save As

When you click this button, a dialog is displayed permitting you to specify the file used to 
save the keyword information in the dialog.



Keyword Definition - Open

If you want to open an existing keyword file, click this button.    A dialog will be displayed 
permitting you to select the keyword file to be displayed.



Keyword Definition - New

If you want to create a new keyword set, click this button.    All of the fields will be cleared.



Keyword Definition - Define

Click this button to save the current keyword definition in the keyword set.    Clicking this 
button either adds a new definition or updates an existing definition depending on whether 
the current keyword name is found in the keyword set.



Keyword Definition - Remove

Click this button if the current keyword definition should be removed from the keyword set. 
To permanently remove a keyword from the keyword set, you must also save the keyword 
set using the Save or Save As... buttons.



Keyword Definition - Base

Clicking this button displays the base keywords dialog.



Keyword Open

This dialog is used to select an AutoDoc keyword file to be opened.



Keyword Open - Filename

Enter the name of the keyword file to be opened into this field.



Keyword Open - File List

This field shows the list of files in the directory which match the selected file type.



Keyword Open - File Type

This field is used to select the type of file to be shown in the file list.



Keyword Open - Directory

This field displays the directory in which the listed files are stored.    You can select a 
different directory by double-clicking on entries in the directory window.



Keyword Open - Drive

This field shows the current drive.    Use this field to select the drive upon which the 
keyword file to be opened is stored.



Keyword Open - OK

Click this button to open the selected keyword file.



Keyword Open - Cancel

Click this button to close the dialog without selecting a keyword file to be opened.



Language Definition

This dialog permits you to define new and modify existing language definitions.



Language Definition - Help

Click this button to obtain help on the dialog.



Language Definition - Language List

This field permits you to enter the name of a new language by typing its name or to select 
an existing language from the list.



Language Definition - Filename Filter

This field is used to define the set of filename patterns which typify this language.    Each 
pattern in the set must be separated by a semi-colon (;).



Language Definition - Comment Regular Expressions

This field is used to enter one or more regular expressions.    These are used during the 
extraction process to remove any comment characters from each line of text read from the 
source file.



Language Definition - Save

Click this button to save all of the changes you have made and to close the dialog.



Language Definition - Cancel

Click this button to discard any changes you have made and to close the dialog.



Language Definition - Define

Click this button to add a new language definition to the list.    If you are modifying an 
existing definition, clicking this button updates the definition.



Language Definition - Remove

Click this button to remove the selected language from the list of defined languages.



Project Browse

This dialog is used to select an AutoDoc project file to be opened.



Project Browse - Filename

Enter the name of the profile file to be opened into this field.



Project Browse - File List

This field shows the list of files in the directory which match the selected file type.



Project Browse - File Type

This field is used to select the type of file to be shown in the file list.



Project Browse - Directory

This field displays the directory in which the listed files are stored.    You can select a 
different directory by double-clicking on entries in the directory window.



Project Browse - Drive

This field shows the current drive.    Use this field to select the drive upon which the project 
file to be opened is stored.



Project Browse - OK

Click this button to open the selected project file.



Project Browse - Cancel

Click this button to close the dialog without selecting a project file to be opened.



Project Open

This dialog lists the last 20 project files which have been opened.    You can select one of 
the listed project files to open or click the Browse... button to select a project file.



Project Open - Project List
This listbox contains the names for up to the last 20 projects you have worked with.    To 
open one of these projects, select the project and click OK or simply double-click the 
project.



Project Open - OK
To open the project highlighted in the project list, click the OK button.



Project Open - Cancel
To close the dialog without selecting a project to open, click the Cancel button.



Project Open - Help
Click this button or enter Alt-? to access on-line help.



Project Open - Browse...
To open a project file not in the list of projects, click the Browse... button.    The project 
browse dialog will be displayed.



Print Options

This dialog is used to select the word processor to use for formatting and printing the target
files associated with the project.



Print Options - Help

Click this button to obtain help on the dialog.



Print Options - Word Processor

This field lists the word processors support by the AutoDocumentation System.    Select the 
entry that corresponds to the word processor you want to use when formatting and printing
the target files.
Once you have selected the word processor, you can specify word processor-specific 
configuration information by clicking the Configure... button.



Print Options - OK

Click this button once you have selected the word processor to use.



Print Options - Cancel

Click this button to close the dialog without changing the word processor to be used.



Print Options - Configure

Once you have selected a word processor from the list, you can click this button in order to 
configure the word processor for use when formatting and printing target files.    The dialog 
that is displayed is specific to the capabilities of the selected word processor.



Print Setup

This dialog is used to select and configure the printer to be used by the word processor 
macroes when target files are printed.



Project Save As

This dialog is used to specify the file into which the project information is saved.



Project Options

This dialog can be used to set project-specific information.



Project Options - Help

Click this button or press Alt-? to obtain help on the dialog.



Project Options - Project

This field shows the file in which the project is saved.



Project Options - Author

This field may be used to specify the author of the project.



Project Options - Keyword File

This field defines the keyword set to be used when extracting information for the target 
files.    This field is required.



Project Options - Startup Directory

This field may be used to specify a startup directory for the project.    Whenever the project 
is activated, this directory is made the current directory.    Specifying a directory in this field 
is most useful when using relative paths for target and source files.



Project Options - Dates

These fields show the dates on which the project was created and last saved.



Project Options - Word Processor
This control lists all of the installed word processors which AutoDoc supports.    You can 
select a specific word processor which will be used to format and print all of the target files 
in the project.    If you select (Default) as the word processor, the word processor selected 
using the print options dialog is used instead.



Project Options - Template
Once a word processor is selected in the Word Processor control, the macro templates 
installed with the word processor are listed in this control.    If you select (Default) for your 
word processor, this control is disabled.

When you add target files to the project, you can specify a specify macro template to be 
used to format and print the target file.    If you do not select a macro template for a target 
file, the macro template you select on this dialog is used instead.    If you select (Default) 
for the macro template on this dialog, the default template selected using the configuration
capabilities of the word processor will be used.



Project Options - OK

Click this button to save the information and close the dialog.



Project Options - Cancel

Click this button to discard any changes you have made and close the dialog.



Project Options - Keyword

Click this button to select the keyword file to be used during the extraction process.



Project Options - Startup

Click this button to select the startup directory for the project.    Whenever the project is 
activated, the current directory is set to the project's startup directory.    This is useful when 
relative paths are used to specify the target and source files.



Project Window

This window is the main window for working with projects.



Project Window - Description

This field displays a description of the project.    The description should describe what is 
produced by the project.



Project Window - Summary

Click this button to enter summary information for the project.    When clicked, the project 
summary dialog is displayed.



Project Window - Target List

This field lists all of the files associated with the project.



Project Window - New

Click this button to add a new target file to the project.    Doing so displays the target dialog
to permit you to enter the necessary information.



Project Window - Duplicate

Click this button to add a copy of the selected target file to the project.    After the copy is 
added, the target dialog is displayed for the copied target's information so that you can 
modify its information.



Project Window - Edit

Click this button to modify the definition of the selected target file.    The target dialog is 
displayed to permit you to modify the information.



Project Window - Delete

Click this button to remove the selected target from the project.    This change is not 
permanent until you save the project.



Project Window - Build All

Click this button to initiate the extraction process.
For each target file associated with the project, a check is made that a) the target file does 
not exist or b) one of the source files associated with the target was modified since the 
target was created.    If either of these conditions is true, all of the source files associated 
with the target are processed in order to create the target file.



Project Window - Make All

Click this button if you want to unconditionally process each of the defined target files.



Project Window - Build Target

Click this button to process only the selected target file.    A check is made that a) the 
target file does not exist or b) one of the source files associated with the target was 
modified since the target was created.    If either condition is true, all of the source files 
associated with the target are processed in order to create the target file.



Project Window - Make Target

Click this button to unconditionally process all of the source files associated with the 
selected target file in order to create the target file.



Project Wizard

This dialog can be used to simplify the creation of new projects.



Project Wizard - Help
Click this button or enter Alt-? to access on-line help.



Project Wizard - Project Name
Enter the name of the new project.    The directory in which the project will be stored is 
shown in the startup directory field (click the Options... button).    Further, the file extension 
is automatically set to .ASP.



Project Wizard - Startup Directory
This field displays the directory in which the project file is stored.    This is also the directory 
which is used as the startup directory for the project.
To change this directory, click the Options... button.



Project Wizard - Keyword File
This field shows the name of the keyword file when extracting information from the target 
files.    You can specify a different file on a target-by-target file basis.



Project Wizard - OK
Once you have entered all of the information needed for the new project, click the OK 
button.    The project will be saved and a new project window will be displayed.



Project Wizard - Cancel
If you decide not to complete the creation of the new project, click the Cancel button.



Project Wizard - Options
If you click this button the project options dialog is displayed.



Project Wizard - Word Processor
This field displays the word processor currently selected for formatting and printing the 
target files.    You can select the word processor using the project options dialog.



Project Wizard - Template
This field displays the macro template currently selected for formatting and printing the 
target files.    You can select the macro template using the project options dialog.



Project Wizard - Target List
The target files added to the project are listed in this field.



Project Wizard - New
To add a new target file to the project, click the New... button.    When this button is 
clicked, the target wizard dialog is displayed.



Project Wizard - Delete
To remove a target file from the list, select the target and click the Delete... button.



Project Wizard - Modify
To view and modify the information associated with a target file, select the target in the list 
and click the Modify... button.    The target wizard dialog will be displayed.



Protect Project

This dialog is used to protect a project from changes.    When you enter a password and 
press OK, the password confirmation dialog is displayed.



Protect Project - Password
Enter a password into this field.    As you enter the password, asterisks ('*') are displayed.



Protect Project - OK
Once you have entered the password, click the OK button.    You will then be asked to re-
enter the password to confirm that the project should be protected.



Protect Project - Cancel
If you decide not to protect the project, click the Cancel button.



Protect Project - Help
Click this button or press Alt-? to access on-line help.



Password Confirmation Dialog

This dialog is displayed after you enter a password to protect the current project.    To 
enable project protection, you must confirm the password by re-entering it on this dialog.



Password Confirmation - Password
Enter the password into this field that was provided on the previous dialog.    Again, as you 
enter the password, asterisks ('*') are displayed.



Password Confirmation - OK
Once you have re-entered the password, click the OK button.    If the passwords you have 
provided do not match, an error message will be displayed (The entered passwords do not 
match.) and the project will not be password protected.    If the passwords do match, the 
project will be protected.



Password Confirmation - Cancel
If you decide not to protect the project, click the Cancel button.



Password Confirmation - Help
Click this button or press Alt-? to access on-line help.



Registration

This dialog is used to register the software.    By supplying the requested information, you 
will receive the latest release of the AutoDocumentation System.



Registration - Help

Click this button or press Alt-? to obtain help on the dialog.



Registration - Name

Enter your name in this field.



Registration - Company

If you are registering a copy of AutoDoc for business use, enter the name of your company 
in this field.



Registration - Address, City, State and Zip Code

Into these fields, enter the address where the software and release announcements should 
be sent.



Registration - Telephone

If you are willing to provide a phone number where you can be contacted, enter it into this 
field.



Registration - Downloaded From

Enter the name of the person, bulletin board or other source from which you obtained your 
copy of the AutoDocumentation System.



Registration - Disk Type

Specify whether you want to receive your registered copy of AutoDoc on 3.5" or 5.25" 
diskettes.



Registration - Registration Type

When you register the AutoDocumentation System, you must specify its intended use.    
Select the type in this group.
Personal You may install the software on one, non-company computer for 

personal use only
Business Single You may install the software on one of your company's computers for 

business use only
Business Site You may install the software on all of your company's machines at a 

single site for business use only
Business Unlimited You may install the software on all of your company's machines 

worldwide for business use only



Registration - Save

Click this button to save the registration information and close the dialog.



Registration - Print

Click this button to save and print the registration information.    The dialog is also closed.



Registration - Cancel

Click this button to discard any changes you have made to the registration information and 
close the dialog.



Script Record

This dialog is used to select the AutoDoc command script file to be created or updated.



Script Run
Using this dialog, you select an AutoDoc command script file to be executed.    You can 
create a command script file using a text editor or using the Record... option on the 
Script menu.



Source Browse

This dialog is used to select an AutoDoc source file to be used.



Source Browse - Filename

Enter the name of the source file to be used into this field.



Source Browse - File List

This field shows the list of files in the directory which match the selected file type.



Source Browse - File Type

This field is used to select the type of file to be shown in the file list.



Source Browse - Directory

This field displays the directory in which the listed files are stored.    You can select a 
different directory by double-clicking on entries in the directory window.



Source Browse - Drive

This field shows the current drive.    Use this field to select the drive upon which the source 
file to be selected is stored.



Source Browse - OK

Click this button to select the source file.



Source Browse - Cancel

Click this button to close the dialog without selecting a source file.



Source File Definition

This dialog is used to add a source file to a target file or to modify a source file previously 
added to the target.



Source File Definition - Help

Click this button or press Alt-? to obtain help on the dialog.



Source File Definition - Filename

This field displays the file to be read during the extraction process.    The filename may 
include wildcard characters.    If a relative path is used, it is relative to the Startup 
Directory entered on the project summary dialog.



Source File Definition - Browse

If you do not know the name or path of the source file, click this button.    The file selection 
dialog is displayed permitting you to identify the source file to be used.



Source File Definition - Description

This field is used to supply a description of the contents of the source file(s) specified by 
the filename field.    This capability is provided for your use and is not used internally by 
AutoDoc.



Source File Definition - File Type

This field identifies the source file's language type.    During the extraction process, the 
comment information associated with the selected language is used to process each line of 
the file.



Source File Definition - Extraction Initiator

This field defines the source file-specific regular expression used to begin extraction of 
information.    If a regular expression is not entered into this field, the extraction initiator 
associated with the target file will be used.    Thus, you should enter a regular expression 
into this field only if it differs from the initiator defined for the target file.
During the extraction process, each line read from the source file is compared to the 
extraction initiator.    If a match is found every line of text in the source file up to (and 
including) the extraction terminator is written to the target file.



Source File Definition - Extraction Terminator

This field defines the source file-specific regular expression used to terminate extraction of 
information.    If a regular expression is not entered into this field, the extraction terminator 
associated with the target file will be used.    Thus, you should enter a regular expression 
into this field only if it differs from the terminator defined for the target file.
After extraction initiator is matched during the extraction process, each line read from the 
source file is compared to the extraction terminator.    If a match is found, no more text is 
transferred to the target file until another match is made with the extraction initiator.



Source File Definition - Keyword File
This field can be used to specify a keyword file to be used when extracting information from
the source file.    By default, the source file is processed using the keyword file associated 
with the target file.

To specify a source file-specific keyword file, enter the filename of the keyword file to be 
used or click the Select... button.



Source File Definition - Select
Click this button if you want to select a keyword file to be used when extracting information
from the source file.    When you click this button, the keyword open dialog is displayed.



Source File Definition - OK

Click this button if the information in the dialog should be saved and the dialog closed.



Source File Definition - Cancel

Click this button to discard any changes you have made and to close the dialog.



Startup Action Prompt

This dialog prompts you for the action to be taken when AutoDoc is executed.



Target Browse

This dialog is used to select an AutoDoc target file to be opened.



Target Browse - Filename

Enter the name of the target file to be used into this field.



Target Browse - File List

This field shows the list of files in the directory which match the selected file type.



Target Browse - File Type

This field is used to select the type of file to be shown in the file list.



Target Browse - Directory

This field displays the directory in which the listed files are stored.    You can select a 
different directory by double-clicking on entries in the directory window.



Target Browse - Drive

This field shows the current drive.    Use this field to select the drive upon which the target 
file to be selected is stored.



Target Browse - OK

Click this button to select the target file.



Target Browse - Cancel

Click this button to close the dialog without selecting a target file.



Target File Definition

This dialog is used to add new and modify existing target files associated with the current 
project.



Target File Definition - Help

Click this button or press Alt-? to obtain help on the dialog.



Target File Definition - Filename

This field defines the name of the target file to be created during the extraction process 
and formatted by the word processor macroes.    The filename may use a relative path.    If it
does, the path is relative to the Startup Directory defined for the project.



Target File Definition - Browse

If you wish to select the target file, click this button.    The file selection dialog is displayed 
permitting you to browse the file system for the target file.



Target File Definition - Description

This field can be used to enter a description of the contents or use of the target file.    It is 
provided for your use only.



Target File Definition - Options

You can associate information such as a title, abstract and preface with each target file.    
This information is added to the target file whenever it is updated and is then formatted by 
the word processor macroes.    By clicking this button, the target options dialog is displayed 
permitting you to view and modify this information.



Target File Definition - Source List

Every target file must be have one or more source files associated with it.    These are the 
files which contain the information to be extracted and formatted.    This field lists all of the 
source files associated with the current target file.



Target File Definition - New

Click this button if you want to associate a new source file with the target file.    The source 
file dialog will be displayed permitting you to enter the necessary information.



Target File Definition - Edit

If you want to modify the information associated with one of the source files in the list, 
select the file and click this button.    The source file dialog will be displayed providing you 
the opportunity to modify the information associated with the source file.



Target File Definition - Delete

If one of the source files in the list should no longer be associated with the target, select 
that file.    This will enable the Delete button.    By clicking it, the file will be deleted from 
the list associated with the target.



Target File Definition - Extraction Initiator

This field defines the default extraction initiator for all source files associated with the 
target.    By entering a regular expression in this field, you do not have to define an initiator 
for each source file.
The extraction initiator is used during the extraction process to determine when to begin 
transferring text from the source files to the target file.    Once a match is made between 
the initiator and a line in the source file, text from the source file will be transferred to the 
target file until a match is made with the extraction terminator.



Target File Definition - Extraction Terminator

This field defines the default extraction terminator for all source files associated with the 
target.    By entering a regular expression in this field, you do not have to define a 
terminator for each source file.
The extraction terminator is used during the extraction process to determine when to stop   
transferring text from the source files to the target file.    Once a match is made between 
the initiator and a line in the source file, text from the source file will be transferred to the 
target file until a match is made with the extraction terminator.



Target File Definition - Word Processor
This field displays the word processor which will be used to format and print the target file.  
The word processor is selected using the project options dialog or using the print options 
dialog.



Target File Definition - Template
If a specific word processor is listed, this field permits you to select the macro template to 
be used to format and print this target file.    If (Default) is selected, the macro template 
selected for the project (using the project options dialog) is used.



Target File Definition - Keyword File
This field can be used to specify a keyword file to be used when extracting information from
the source files associated with this target file.    By default, the keyword file assigned to the
project is used.

To specify a target-specific keyword file, enter the filename of the keyword file to be used or
click the Select... button.



Target File Definition - Select
Click this button if you want to select a keyword file to be used when extracting information
from the source files assigned to this target file.    When you click this button, the keyword 
open dialog is displayed.



Target File Definition - OK

Click this button save the information in the dialog and to close the dialog.



Target File Definition - Cancel

Click this button to discard any changes made to the information in the dialog and to close 
the dialog.



Target Options

This dialog is used to enter information to be placed into the target file.



Target Options - Help

Click this button or press Alt-? to obtain help on the dialog.



Target Options - Table Of Contents

Select this option in order to have a table of contents placed into the formatted document.



Target Options - Alphabetize

Select this option if you want the formatted headings sorted alphabetically.



Target Options - Page Header

Select this option if you want a header on each page of the formatted document.



Target Options - Page Footer

If you want a footer inserted on each page of the formatted document, select this option 
and enter the text to be inserted into the edit field.



Target Options - Title

If you want a title placed onto the first page of the formatted document, enter the text of 
the title into this field.    To enter a multiline title, press Ctrl-Enter to separate each line.



Target Options - Abstract

If you want an abstract placed onto the title page of the formatted document, enter the 
text of the abstract into this field.    To enter a multiline abstract, press Ctrl-Enter to 
separate each line.



Target Options - Preface

If you want a preface placed onto the page following the table of contents in the formatted 
document, enter the text of the preface into this field.    To enter a multiline preface, press 
Ctrl-Enter to separate each line.



Target Options - OK

Click this button to save the information in the dialog and close the dialog.



Target Options - Cancel

Click this button to discard any changes made and close the dialog.



Target Wizard

This dialog is a simplified version of the Target File Definition dialog.    You can access this 
dialog from the Project Wizard dialog.



Target Wizard - Help
Click this button or enter Alt-? to obtain on-line help.



Target Wizard - Target Name
This field is where the file name for the target file should be entered.    The directory where 
the target file will be stored is the same as the startup directory for the project.    The file 
extension for the target file is set to .XTR.



Target Wizard - Begin Extracting With
This is the regular expression which is used to determine when text from the source files is 
to be copied to the target file.    When a line of text in a source file matches this regular 
expression, the line plus all that follow will be copied to the target file.



Target Wizard - Stop Extracting After
This is the regular expression which is used to determine when to stop copying text from 
the source files to the target file.    When a line of text in a source file matches this regular 
expression, the text following this line will not be copied to the target file.



Target Wizard - Options
To set the options (such as table of contents, title, abstract, etc.) associated with the target 
file, click the Options... button and the Target Options dialog will be displayed.



Target Wizard - Source Files
This list shows the source files associated with the target file.



Target Wizard - Delete
If a source file should be removed from the list, select it and click the Delete button.



Target Wizard - Add
To add a new source file to the list, select the source name and enter the directory where 
the source files are located.    Then, click the Add button.



Target Wizard - Source Name
This field lists all of the source files associated with the defined languages (see Source File 
Definition).



Target Wizard - Source Directory
Once a source name has been selected, the path to the directory where the source files are
located can be entered into this field.    The path can be relative to the project's startup 
directory.



Target Wizard - Browse
To select the directory where the source files are located, click the Browse... button.    The 
Source Browse dialog is displayed so that directory can be determined.



Target Wizard - OK
To save the target file description, click the OK button.    Doing so will add the definition of 
the target file to the project.



Target Wizard - Cancel
If the changes made to the target file should not be saved, click the Cancel button.



Tools Management

Use this dialog to manage the list of applications available on the Tools menu.



Tools Management - Help

Click this button or press Alt-? to obtain help on this dialog.



Tools Management - List

This field lists all of the items currently selected for inclusion on the Tools menu.



Tools Management - Information

These fields list the command and startup directory for the entry selected in the tools list.



Tools Management - Add

Click this button to select a new tool to add to the menu.    The tool selection dialog is 
displayed to assist you.



Tools Management - Edit

Click this button to modify the information associated with the tool selected in the tool list.



Tools Management - Remove

Click this button to remove the selected tool from the tool list.



Tools Management - Separator

Click this button to insert a separator bar into the tools list ahead of the selected tool.



Tools Management - OK

Click this button to save the current tool list and close the dialog.



Tools Management - Cancel

Click this button to discard any changes made to the tool list and close the dialog.



Tools Management - Move Up

Click this button to move the currently selected tool up in the list of tools.



Tools Management - Move Down

Click this button to move the currently selected tool down in the tool list.



Tool Selection

This dialog is used to select a tool to be launched immediately or added to the list of tools 
on the Tools menu.



Tool Selection - Help

Click this button or press Alt-? to obtain help on the dialog.



Tool Selection - Applications

This field lists the applications listed in the Program Manager Group Files in your Windows 
directory.



Tool Selection - Description

This field lists the descriptive name of the item selected in the Applications: list.    If you 
used the Browse... button to select an application, this field is blank.
If you accessed this dialog from the Tools dialog, you must provide a description (which is 
listed on the Tools menu).    If you selected the Execute... option from the Tools menu, 
you do not have to specify a description.



Tool Selection - Command

This field specifies the command string to be used to launch the tool.    Any command-line 
parameters required by the application should be specified here.



Tool Selection - Startup Directory

This field is used to specify the directory to be considered the startup directory for the tool. 
Prior to executing the command string, this directory is made the current directory.



Tool Selection - OK

Click this button to use the specified tool.



Tool Selection - Cancel

Click this button to close the dialog without making a selection.



Tool Selection - Browse

Click this button to display a dialog which permits you to browse the file system for a tool.



Unprotect Project

This dialog is used to reverse the action of the project protection dialog.    To unprotect the 
project, enter the password used to protect it.



Unprotect Project - Password
To remove the password protection from a project, enter the project's password into this 
field.    As you enter the password, asterisks ('*') are displayed.



Unprotect Project - OK
Once you have entered the password, click the OK button.    If the password matches the 
one used to protect the project, the protection will be removed from the project.    If it does 
not match, an error message will be displayed (The specified password does not match the 
project's password.).



Unprotect Project - Cancel
If you decide not to remove the password protection from the project, click the Cancel 
button.



Unprotect Project - Help
Click this button or enter Alt-? to access on-line help.



Starting a Project

To create a new project
1. Do one of the following

From the File menu, select New (Alt, F, N)
From the Toolbar, click the New button
From the Project menu, select Project Wizard (Alt, P, 

W)
From the Toolbar, click the Project Wizard button

To open an existing project
1. Do one of the following

From the File menu, select Open... (Alt, F, O)
From the Toolbar, click the Open button

2. On the project open dialog, do one of the following
Select a project file from the displayed list
Click the Browse... button to select a project using 

the Project Browse dialog
3. Choose the OK button.

Regardless of whether you create or open a project, a project window will be opened.    If 
you have opened an existing project, the project window will display the contents of the 
project.



Setting Project Options Information

1. On the project window, click the Options... button
The Project Options dialog is displayed.

To specify the project author
1. Put the input focus into the Author field by doing on of the 

following
Press Alt-A
Press tab until focus is in the Author field
Using the mouse, click in the Author field

2. Type the name of the project's author

To specify the keyword set to use
1. Put the input focus into the Keyword File field by doing one 

of the following:
Press Alt-K
Press tab until focus is in the Keyword File field
Using the mouse, click in the Keyword File field

2. Type the name of the keyword file to be used during 
extraction

To select the keyword set to use
1. Do one of the following:

Press Alt-W
Using the mouse, click on the Keyword... button

The Keyword Selection dialog will be displayed.
2. Using the Keyword Selection dialog, pick the keyword file.

Once the correct file is specified, click the OK button.

To select the startup directory
1. Do one of the following:

Press Alt-T
Using the mouse, click on the Startup... button

The Directory Selection dialog will be displayed.
2. Using the Directory Selection dialog, pick the directory to be 

used as the startup directory for the project.

To specify the startup directory
1. Put the input focus into the Startup Direcotry field by doing 

one of the following:
Press Alt-S
Press tab until focus is in the Keyword File field



Using the mouse, click in the Keyword File field
2. Enter the path of the startup directory

To select the word processor
1. Do one of the following:

Press Alt-P
Using the mouse, click on the Word Processor field

2. Using the up and down arrow keys, select the word 
processor to use when printing the project's target files

To select the word processor template
1. Do one of the following:

Press Alt-m
Using the mouse, click on the Template field

2. Using the up and down arrow keys, select the word 
processor template to use when printing the project's target 
files



Working with Target Files

Target files are created during the extraction process. These are the files which contain the 
extracted text which is formatted by a word processor macro.    A single project may have 
more than one target file.    Further, multiple projects may share a single target file.
Separate arget files are generally create for two reasons.    First, as shown by the AutoDoc 
User's Manual, you can use separate target files for each chapter of a multi-chapter 
document.    Another common use is for each target file to be formatted into a separate 
(but related) document.    This is typical for application API information.

To create a new target definition
1. On the project window, do one of the following

Press Alt-N
Click the New... button with the mouse

2. The target file window is displayed.
3. Enter the name of the target file in the Target File field.

Enter the name directly
Click the Browse... button to select the name of the 

target file

To modify an existing target definition
1. In the Target List on the project window, select the target file

to be modified.
Press Alt-T and use the arrow keys to select the target
Using the mouse, click on the target to be modified

2. Do one of the following
Press Alt-I
Click the Edit... button

The target file window is displayed and shows the information associated with the target 
file you selected.

Adding a source file to a target
1. Do one of the following from the target file dialog.

Press Alt-N
Using the mouse, click the New... button

2. The source file is displayed.    Using this dialog, enter all of 
the information about the source file to be added to the 
target file.

3. When the target file dialog is redisplayed, the new source file
will be listed in the source list.

To modify an existing source file in a target



1. In the source list on the target file, select the source file to 
be modified.

Press Alt-S and use the arrow keys to select the 
target

Using the mouse, click on the source file to be 
modified

2. Do one of the following
Press Alt-I
Click the Edit... button

3. The source file dialog is displayed and shows the information
associated with the source file you selected.

4. When the target file dialog is redisplayed, the new source file
will be listed in the source list.

Specifying a title, abstract, preface, header or footer and table of contents
1. To access the target options dialog, do one of the following.

Press Alt-O
Using the mouse, click the Options... button

2. The target options dialog is displayed
3. In the appropriate field, enter the information to be output to

the target file during extraction



Working with Source Files

Source files contain the information to be extracted and placed into target files.    Each 
target file in a project must have at least one source file associated with it.

To name a source file
1. With the Source File dialog displayed, place the input focus 

into the File field
2. Do one of the following.

Press Alt-B and select the source file
Enter the path to the source file
Click the Browse... button with the mouse and select 
the source file

To select the source file's language
1. With the Source File dialog displayed, place the input focus 

into the Source file type field
2. From the list of languages, select the language of the source 

file.



Extracting Target Files

There are four ways to extract the target files from your source files based upon the 
following two questions.

Should all target files be extracted?
Should a target file be extracted only if necessary?
A target file requires extraction if (a) it does not currently exist or (b) one of the source 
files associated with the target file has been modified since the target file was last 
extracted.

Use your answers to these questions to select the appropriate extraction operation from 
the table below.

Extract Only If 
Necessary

Force Extraction To 
Occur

Extract All Targets Build All Make All
Extract the Selected Target Make All Make Target

For each of these operations, you can click the appropriate button on the Project Window, 
select the appropriate option from the Project menu, or use the accelerator key listed for 
the operation on the Project menu.



Printing

Once you have extracted the target files in your project, you can format and print them.    
To do so, select the Print... option from the File menu or click the print button on the 
Toolbar.
Depending upon the selection you made on the Print Options dialog, the appropriate 
module will be loaded and executed.    Generally, a dialog will be displayed which lets you 
specify which target files should be processed, select the processing to occur (i.e., format 
only, format and print,...) and specify other word processor-specific options.



Saving a Project

At any time, you can save a project's information.
To Save A Project To A Specific File

1. Do one of the following:
If the project has not been previously saved, use the 
mouse to click on the Save button on the Toolbar or 
select Save from the File menu
From the File menu, select Save As...

The Project Save As is displayed.
2. Use the dialog to specify the file into which the project's 

information is written.    Click OK to close the dialog
The file you specified will be created and the project 
information written to it.

To Save A Project Already Saved
1. Do one of the following:

Use the mouse to click on the Save button on the 
Toolbar
From the File menu, select Save

The project information will be output to the project file 
previously created.
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